Lab 11 (due April 20), EES6513 Spring 2009, UTSA, Dr. Hongjie Xie
http://www.utsa.edu/lrsg/Teaching/ 
Your Name _____________________.
3D Analysis

Purposes: getting familiar with ArcGIS 3D Analyst
(Note: You can use this modified version or you can directly use the ESRI online version, the code for the online course was passed to you in the beginning of the semester)
Based on tutorials found in ESRI Visual Campus (campus.esri.com), "Introduction to ArcGIS 3D Analyst”
Lab data: Copy the directory of Lab11 (3D-Analysis1, 3D-Analysis2, 3D-Analysis3) under \\129.115.25.240\XIE_misc\EES6513\ into your local computer
Part 1.1 3D Analyst in ArcCatalog
Step 1.  Start ArcCatalog and load 3D Analyst extension

I hope you are very familiar with ArcCatalog now. For example, you should already know that you can preview your spatial data usually in two models: Geography and Table. Especially for raster (image or grid) and TIN file, you can view them in geography only, but for vector data or feature classes, you can view them either the Geography or the table. Today, when you turn on the 3D analyst extension, you will find that you can view your spatial data in four models: Geography, Table, 3D view and Globe View. Let’s test it. 

From the Tools menu, choose Extensions, in the Extensions dialog, check the box next to 3D Analyst, click Close.

Step 2. Preview 3D TIN data

In the Catalog Tree, click the plus sign next to your module folder (…\3D-Analysis1) to expand its contents. Click the Preview tab above the display. The TIN (shavano_tin) is displayed in 2D (a planimetric view) when it is in a Geography preview model (below the display), or in 3D (a perspective view) when it is in the 3D view. In the 3D view, you can drag and move the 3D image.

Step 3. Preview 3D features

Navigate through the Catalog Tree and click the shavano_hike.shp file located in your module folder. (Depending on your ArcCatalog Options settings, the .shp extension may or may not appear after the file name). Click the Preview tab. You will find 4 preview models: table, geography, globe view and 3D view. Click the table model, you can know that this record represents a 3D feature because the Shape field value is Plotline ZM. Click the geography model, you only see 2D line. Click the 3D view model, you see the 3D lines. In this model, you can drag and move the line.

Step 4. Preview 3D raster data (can’t be directly viewed)
a. Click the shavano raster layer located in your module folder, Make sure the Preview dropdown list is set to 3D View. But you can see only 2D not 3D. 

b. Create a layer file of the raster, by right-click the shavano raster and choose Create Layer, Name the layer Shav_layer and save it in your MyData folder. Navigate to the MyData, click Shav_layer, you can still only see 2D not 3D.
c. Right click the Shav_layer and click Properties. In the Layer Properties dialog, click the Base Heights tab. Choose the “Obtain heights for layer from surface” option, select the shavano raster layer as your Base Height. Click OK. Now you should see a 3D view but in grayscale color ramp.
d. Right click shav_layer in the Catalog Tree and select Properties, click the Symbology tab, In the Color Ramp dropdown list, right-click on the colors (not on the dropdown arrow). On the context menu, click Graphic View to uncheck it. The image of the color ramp is replaced by its name. Click the Color Ramp dropdown arrow and scroll down until you see Elevation #1. Click to select it. Click OK. Now you see color 3D. You can add shading to improve the view.
e. Right click shav_layer in the Catalog Tree and select Properties. Click the Rendering tab. In the Effects frame, check "Shade areal features relative to the scene’s light position." Click OK. You see better 3D view.
Question 1. Copy and paste one of the views to here to your homework and roughly explain the color ranges related to your elevation distribution. For example, white-gray color represents the highest elevation, ….
Step 5. Load the 3D View tools.

From the View menu, choose Toolbars, and check 3D View Tools. This set of tools lets you navigate around your data in 3D, query the features in your data, and create perspective-view thumbnails of your data. Other than the Launch ArcScene [image: image1.png]


button and the Create Thumbnail button [image: image2.png]


, you can find the same tools, with the same functionality, on the toolbars in ArcScene. You will learn how to use these tools in the next steps.

Part 1.2. 3D analyst and ArcScene
Step 1. Launch ArcScene [image: image3.png]


 and familiar with tools
You can launch the ArcScene [image: image4.png]


 from 3D View Tools of ArcCatalog, 3D Analyst of ArcMap, or Start->Programs->ArcGIS->ArcScene. From the File menu, choose Open. Navigate to your module folder (…\3D-Analysis1) and open the Navigate.sxd document. Get familiar with each of the following tools.
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Zoom In/Out 
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Center on Target 
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Zoom to Target 
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Set Observer

Step 2. Fly tool (only in the ArcScene not in the ArcCatalog)

Review the fly tool instructions below and try to get familiar with each of them:
Fly tool Instructions 

	Action
	Command

	Activate Fly Tool
	Click Fly Tool then left-click on the scene

	Start flight
	Left-click

	Increase speed
	Additional left-clicks

	Decrease speed
	Right-click

	Stop flight
	Press the Escape key, or click the middle mouse button


	Note: you can also fly backward by starting flight with a right-click. Increasing and decreasing speed while flying backward is the same as flying forward but the commands are reversed (right click to increase speed, left click to decrease speed).


Step 3. Animated rotation

a. In the Table of Contents, right-click Scene Layers and choose Scene Properties. Click the General Tab. Check the box next to Enable Animated Rotation. 

b. Click the Navigate tool, Place your cursor at the right side of the display. (When animated rotation is enabled, the Navigate tool's cursor has a circle placed around it [image: image11.png]


 ). Hold down the left mouse button, drag the cursor to the left, and release the mouse button while dragging from right to the left. Take your hand off the mouse. The display should continue to rotate after you let go of the mouse. If it doesn't, try again and make sure you are releasing the mouse button while dragging the cursor across the display.
Step 4. Interact with rotation

a. You can use other tools in the scene while the data is rotating. As soon as you click another tool, ArcScene temporarily suspends the rotation

b. To restart the rotation, click the Navigate tool. For example, if something on Mt. Shavano catches your eye while rotating by, you could click the Zoom In/Out tool, zoom to the area of interest, inspect it, then restart rotation by again clicking the Navigate tool
c. Click the Zoom In/Out tool, Notice that rotation stops. Zoom in a small amount, click the Navigate tool. Rotation starts again
d. The axis of rotation is based on the scene’s target. Changing the target changes the axis of rotation. Click  Target tool [image: image12.png]


, then click any place of the surface you want it to be the center, click the Navigator tool again, now the rotation around the new target (center).
e. To stop rotation, Make sure your mouse cursor is over the display and press the Esc key.
Step 5. Set targets and observers

a. Open Targets.sxd. The scene contains a Mt. Shavano layer and a Target and Observers layer. As the same as step 3a to check the Enable Animation Rotation
b. Use Target tool [image: image13.png]


 to center the Target (a black square), which is the cabin location. Make an animated rotation follow step 3b.
c. Click Full Extent button, Click the Zoom to Target tool [image: image14.png]


. Click the Target. Click the Navigate Tool, the rotation starts again. 
d. Click Full Extent button, set the cabin location (target) to the center again (using [image: image15.png]


). Click Set Observer tool [image: image16.png]


, click the red square (observer 1). Now you are viewing the cabin from the southeast.
e. Click the Add New Viewer tool [image: image17.png]


. Tools that operate in the main viewer also work in secondary viewers. 
f. Set the cabin to the center, set the blue square (observer 2) as an observer point. This is southwest perspective view.
g. You can change the name of the view1 to what you want such as Southwest View from Window menu to Viewer Manager.
h. Save the document to MyData fold.

Question 2, just copy and paste one of the views in the Targets.sxd to your homework.
Part 2. Create a TIN from points, lines, and polygons
Step 1. Preview the Big Bear layers


The study area, located in the San Bernardino Mountains of southern California, is shown as a green rectangle in the following graphic. The study area includes Big Bear Lake, a popular recreation area.
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In the Catalog Tree (…\3D-Analysis2), 

a. click bbpts.shp. In the display window, click the Preview tab. Preview the geography and the table. You will use this layer as mass points to define the TIN structure. The layer has 1,480 points. The elevation values are stored in a field called ELEV.

b. Click bbbnd.shp and preview its geography. This layer consists of a single rectangular feature. You will use it as a soft clip polygon to define the TIN boundary.

c. Click bblake.shp. Preview its geography and table. The lake’s elevation is 2,056 meters. You will use this layer as a replace polygon, which means that the interpolated elevation values (calculated from the mass points) will be replaced by the value 2,056 for the entire area of the lake. In other words, the TIN will have a uniform elevation here, as it should.

d. Click bbrivers.shp and preview its geography. 

You will add this layer as hard breaklines, so that no triangles can cross the line of a river. This means rivers will follow ridges and not run along the sides of hills.

Step 2. Create a TIN
a. Open the bigbear.sxd in ArcScene.
b. From the 3D Analyst menu, choose Create/Modify TIN, and click Create TIN From Features. In the dialog's Layers box, check Elevation Points. Make sure the height source is ELEV and the triangulation is mass points. Check Rivers and set its height source to < None >. Make sure it is triangulated as hard line. Check Big Bear Lake. Make sure its height source is set to ELEV. Set the triangulation to hard replace. Check Boundary. Set the height source to < None >. Make sure it is triangulated as soft clip. Set the output TIN location to your \MyData folder and name it bigbear. Click OK. The TIN is created and added to the scene

Step 3. Resymbolize and examine the TIN
a. Turn off all layers except the TIN layer. Rename the layer Big Bear Elevation and zoom to the layer. Open the layer properties for Big Bear Elevation and click the Symbology tab. In the Show box, make sure that Edge Types is highlighted. Click Add All Values. Change the symbol colors, if necessary, so that you can distinguish them easily. In the Show box, uncheck Elevation. Click OK on the Layer Properties dialog.

b. Zoom in and examine the TIN structure in different places. The hard breaklines representing rivers (blue in the following graphic) always form triangle edges. The hard edges that define the lake always form triangles edges as well.

c. Open the layer properties for Big Bear Elevation. In the Show box, uncheck Edge types and check Elevation. Click OK.

Step 4. Display the rivers and the lake

a. Turn on the Rivers layer and the Big Bear Lake layer.  Open the layer properties for the Rivers layer and click the Base Heights tab. Set the base heights to the bigbear surface (the TIN), and click OK. Do the same for the Big Bear Lake layer.
b. Examine the TIN from different perspectives and identify some locations. When you identify a location, you get the elevation, slope, and aspect values, as well as any tag values you have added. (In this case, there are none.). Identify a few locations on the lake. You should always get the elevation value 2,056 and the aspect value -1 (flat).

c. Save the document (project) to MyData

Question 3, just copy and paste one of the views in the Step 4 into your homework.

Part 3. 3D analysis
Part 3.1 Find steepest path

The Steepest Path tool calculates the steepest downhill path from a given point on a TIN or raster surface. You can access this functionality from the 3D toolbar in ArcMap™ or ArcScene. 

In this exercise, you will find the steepest path from the headwaters (sources) of two different streams, then compare these to the actual stream locations. 

The study area, represented with a red box in the graphic below, is located in the San Bernardino mountains in southern California.
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Step 1. start ArcScene, and open …\3D-Analysis3\steep_path.sxd. 
The scene contains a TIN layer representing a portion of the San Bernardino mountains, and two point layers representing two stream heads.
Step 2. find steepest path from Stream Head 1

Zoom in close to the Stream Head 1 layer, Click the Create Steepest Path tool [image: image20.png]


on the 3D Analyst Toolbar. Center the cursor’s crosshairs over the yellow point symbol and click. The path continues from the point you clicked until it reaches either the perimeter of the surface or a point into which all surrounding areas flow (a pit). Click the Full Extent button and look at the full length of the Steepest Path (a 3D graphic line).


To change the color of the path using the Graphic toolbar (View menu to Toolbars to Graphics). If the deepest path is not selected, click the Select Graphics tool [image: image21.png]


, then click the path. It will highlight in gray once selected. On the Graphics toolbar, click the Line Color dropdown arrow [image: image22.png]


and select Solar Yellow. Make sure the Select Graphics tool is selected. Unselect the steepest path by clicking somewhere in the scene that is not on the path.
Step 3. find steepest path from Stream Head 3

Zoom in close to Stream Head 2 and create the steepest path from it.

Step 4. compare the steepest paths to known river locations


If the TIN accurately models reality, the steepest paths should closely match the actual stream locations. The Rivers are stored as hard edges in the TIN. 


To challenge your capability, please refer to step 3 in Part 2 of this lab, to turn on the known rivers in the TIN.  Compare the steepest paths you created to the stream locations. Both paths deviate at different places along the streams and both end prematurely.  This TIN is a coarse surface that was made to draw fast for the exercise. It’s not really suited for hydrologic modeling. You would need to make quite a few improvements if you wanted to use it as a base for modeling stream flow. This would entail collecting more sample points along the streams, then recreating the TIN with the additional points. It's also worth noting that very slight alterations in a surface model may lead to significantly different results. Even with a good tool and a good model, a small error in a crucial place may lead to bad results.

Part 3.2 Profile line steepness

Suppose you were planning a backpacking trip through the Cascade Mountains in Washington state. Provided you had an elevation surface and 3D Analyst, you could generate a profile graph of the journey that showed distance and elevation along the hike. This profile would reveal where you would encounter steep slopes, easy flatlands, or treacherous cliffs. To create a profile graph, you must use the 3D Analyst toolbar in ArcMap (not ArcScene) and have either a TIN or raster surface loaded. In this exercise, you will create profile graphs that follow north-south and east-west lines across the cone of Mount St. Helens. Mount St. Helens, located in southern Washington, erupted violently in 1980. 

Step 1. Start ArcMap and 3D Analyst, and open …\3D-Analysis3\StHelens.mxd

The scene contains an elevation raster of Mount St. Helens draped over a hillshade, and two shapefiles: Transects and Markers. 

Step 2. Create the east-west profile graph

Turn on the Transects layer, which contains two 3D line features (question: how do you know it is 3D feature?), one running north-south and the other east-west.

Click the Select Features tool [image: image23.png]


and select the line that runs east-west, Click the Create Profile Graph tool [image: image24.png]


 in the 3D Analyst. It may take a moment for the graph to generate. Elevation is shown along the Y axis. Distance is shown on the X axis. The elevation along the profile ranges from approximately 4,000 to 8,000 feet. The distance of the profile line is nearly 30,000 feet (5.7 miles). This is a 2D distance measure, which means that changes in elevation are not accounted for in the measurement. The profile graph reflects the direction of the line feature. For example, the line you just used to create the profile was digitized from east to west, and in the graph, distance along the x-axis is measured from east to west.


In the graph Manger (from Tools to Graphs to Mange), click "Profile Graph Title" to highlight it, then click it again so that you can type into it. Change the name of the graph to East-West, then click Close. The change is reflected on the graph’s title bar. Right-click the title bar and click Properties. Change the title to Mount St. Helens and the subtitle to East to West Profile.

Step 3. Create the north-south profile graph


Use the same method as above (step 2). And change the graph’s name to North-South. Change the title to Mount St. Helens, and the subtitle to North to South Profile.

Step 4. Draw a 3D line graphic and generate a profile from the 3D graphic line

You can also create a profile from a 3D line graphic. Turn off the Transects layer. Turn on the Markers layer. Click the Interpolate Line tool [image: image25.png]i3



. Click the blue marker on the south side of the Volcano, then double-click the yellow marker on the north side. Leave the graphic selected. This line matches the one used in the last step, but was digitized in the opposite direction (south to north instead of north to south).


Create a profile from the 3D line graph, change the graph name to South-North. Change the title to Mount St. Helens and the subtitle to South to North Profile.
Step 5. Compare the North-South profile to the South-North profile as part of your lab submission.
Part 3.3 Calculate area and volume

You can use 3D Analyst to calculate the area and volume of a surface above or below a specific elevation. For example, you can determine how much fill material would be produced for road construction if you cut off the top of a hill at a given elevation. Or, you can estimate the volume of water a river valley would hold if dammed and flooded to a particular elevation. You can make area and volume calculations in ArcMap or ArcScene using TIN or raster data.  In this exercise, you will calculate the area and volume of a proposed lake named Muddy Puddle. The desired elevation of the water table is 1,114 feet above sea level. The lake level is expected to fluctuate seasonally between 1,100 and 1,114 feet.  The land planned for flooding is outlined in yellow on the aerial photo below. 
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Step 1. Start ArcScene, and open C:\GTKArcGIS\Lab10b\3D-Analysis3\area&volume.sxd

The desired water level of the Muddy Puddle is 1,114 feet. Contours were created to locate this elevation on the surface. Turn on the Contours layer. The Flood Level layer was created to show the extent and elevation of Muddy Puddle. Turn on the Flood Lever layer. The main dam will be constructed on the south side of the lake between two large hills. The emergency spillway gates will be built just north of the main dam between two hills on the west side of the lake. Turn on the Dam Locations layer. 


From View to Scene Properties to General, change the Vertical Exaggeration from none to 5. You will see better 3D. Use the Navigate tool or the Fly tool to explore the scene.

Step 2. Add the Flood TIN


Area and volume statistics made with 3D Analyst are calculated for the entire surface. In this case, the extent of the Study Area TIN is greater than the extent of the proposed lake. If you use this TIN as the base data for the area and volume statistics, the statistics will reflect the entire surface, not just the area covered by the lake. 
Turn off all the layers in the Table of Contents. Click the Add Data button, navigate to the 3D-Analysis3 folder and add flood_tin. The extent of flood_tin matches the extent of Muddy Puddle. 
Step 3. Calculate area and volume statistics


From the 3D Analyst menu, point to Surface Analysis, then click Area and Volume. For Input surface, select the path containing flood_tin from the dropdown list. In the Reference parameters frame, for Height of plane, enter 1114 then choose the option to "Calculate the statistics below the plane."  Leave the Z factor at 1.000. (This is a conversion factor you can set if your z units differ from your x, y units.) In the Output statistics frame, check the box to "Save/append statistics to text file."  Click the browse button and navigate to your MyData folder. Accept the default name areavol.txt and click Save. Click the Calculate statistics button.  ArcScene calculates and reports the 2D area, surface area, and volume (the units are feet) in the Output statistics frame. 

What’s the difference between 2D area and surface area? 
Surface area is measured along the slopes of the surface and accounts for changes in elevation. 2D area is based on the same extent as the surface area, but assumes the surface is flat. The greater the difference between these two values, the rougher or steeper the slope.
Step 4. Change the plane height and recalculate area and volume

You also need the lake volume when the water table is at 1,100 feet. In the Reference parameters frame, change the Height of plane to 1100. In the Output statistics frame, click Calculate statistics. The new statistics are reported on the dialog and are also appended to the areavol.txt file. Click Done.


Using the text editor of your choice, open the areavol.txt file located in your C:\GTKArcGIS\Lab10b\3D-Analysis3\MyData folder. The area and volume statistics for both plane heights (1,100 and 1,114 feet) were written to this file. The file also contains all of the settings made prior to the calculation. You now have estimates of the lake’s water capacity at two elevations. This information can help determine how long Muddy Puddle will take to fill, and how useful it will be as a water reservoir. 
Question 4: Submit this table as part of your lab submission
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